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This guide will take you through the relevant steps so that you will be able to make the 
most of your LogTag products. The guide is structured into chapters that will guide you 
through the process of installing the software, using the LogTag products and lastly some 
of the options that are available to you for making your efforts and experience of using 
the software as efficient, effective and pleasant as possible.  

The chapters in this guide are placed in an order that you will need to follow in order to 
successfully use the LogTag products first time. Experienced users of the software may 
choose to skip the first two chapters. However, if you are about to use a newer version of 
a LogTag and/or Interface Cradle, we recommend you at least skim the installation 
chapter for any relevant changes that should be performed prior to using your new 
version of LogTag hardware.  

This guide covers all the features included in version 2.0 of the LogTag Analyzer software. 
The chapter "Finding your software version (on page 140)" included later in this guide will 
help you through the process of finding out what version of the LogTag Analyzer software 
is being used and will help explain and determine if this version of the guide refers to the 
version of the software being used. The chapter "Getting updated software (on page 
138)" included later in this guide will help you through the process of obtaining an 
updated copy of the software. Therefore, if you find a feature described within this guide 
that does not appear in your software and/or a feature within the version of software 
being used that is not described in this guide, then we recommend you obtain a newer 
version of the software and/or a newer version of this guide. You may obtain a free online 
copy of the latest version of this guide from the LogTag Recorders Internet site, 
www.logtagrecorders.com. 

Although this guide includes all the relevant information to install and use the product 
range supplied by LogTag Recorders, there are at times an expectation that the reader is 
familiar with using their computer and the Windows® operating system. If a feature of 
the software is specific to a version of the Windows® operating system, the guide will 
indicate appropriately for you the relevant differences. 

Feedback, positive or negative, about the software, the LogTag products and/or this guide 
is welcome. If you believe the products could be improved, you are welcome to send us 
your comments and we will do our best to include the improvements in a future release. 
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To make use of your LogTag you will need to first install the software on your computer. 
This will allow you to prepare your LogTag(s) for use, retrieve the readings the LogTag(s) 
have recorded, and analyze the data. This chapter will take you through the steps 
necessary to successful install the software on to your computer so you can begin using 
your LogTag(s). The process of installing the LogTag Analyzer software should be very 
familiar to users that have previously installed other software and therefore some 
experienced users may choose to only skim read or entirely skip this chapter. If you are 
new to using a computer and/or unsure about installing the software, we recommend you 
read the remainder of this chapter. 

In This Chapter 

System requirements .............................................. 8 
Getting a copy of the software ................................ 8 
The installation process .......................................... 9 
Upgrading from earlier versions .............................. 10 
Starting the software .............................................. 11 
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System requirements 
To ensure that the software will be able work with your computer, the following lists the 
minimum specifications required: 

 Pentium II 233MHz processor 

 64MB RAM 

 45MB free disk space 

 Windows NT, Windows 2000, Windows XP, Windows VISTA or WIndows 7 

 Internet Explorer 5.0 or later 

 1 available serial port and/or 1 available USB port, depending on purchased interface 

 800 x 600 screen resolution 

 256 screen colors 

The recommended specifications are: 

 Pentium V or later 

 512MB of available RAM 

 Windows XP, or later 

 Internet Explorer 6.0 or later 

 65535 (16bit), or more, screen colors. 

 1024 x 768, or higher, screen resolution. 

If you are unsure of what your computer specifications are, please read the section about 
"Finding your computer specifications (on page 144)", which will help you locate the 
relevant information. 
 

Getting a copy of the software 
The software is available for download from the LogTag Recorders Internet site, 
www.logtagrecorders.com. LogTag Recorders does not charge for the download of the 
LogTag Analyzer software or for the updates to the LogTag Analyzer software. You are 
welcome to distribute copies of the LogTag Analyzer software provided it is distributed in 
the packaged format as originally downloaded from the LogTag Recorders Internet site. 
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When you visit the LogTag Recorders Internet site, follow the software navigation links to 
obtain a download link for the latest version of the LogTag Analyzer software. The request 
to download LogTag Analyzer software from the LogTag Recorders Internet site will result 
in an e-mail automatically being sent to you with the download link for the latest version. 
To begin the actual download of the software process, click on the link provided in your 
e-mail, and your e-mail software will prompt you to save or open the file. 

 

We recommend choosing the option to save the file to your disk and to save the file to 
your desktop. If you are an experienced user you may wish to save the file to a different 
folder of your choosing. Once the installation process has been completed, this file can be 
safely deleted, as it is not required for using the software. 

Only one file needs to be downloaded to enable installation of the software on your 
computer. Once the relevant installation file has been downloaded to your computer, you 
only have to open the file to begin the installation process.  
 

The installation process 
To install the LogTag Analyzer software, first you need to locate the installation file that 
was downloaded from the LogTag Recorders Internet site. To begin the installation 
process open the installation file, which is typically performed by double clicking the left 
mouse button. 

Tip: Double clicking a mouse button, implies the user clicks the same mouse button in 
quick succession. 

The installation process will guide you through the relevant steps to correctly and 
successfully install the software. If you have installed any other software, you should find 
the installation process familiar. To proceed through each step of the installation process, 
click the "Next" button. If you want to change a previous step you can click the "Back" 
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button. When the process is ready to be completed, clicking the "Finish" button, when it 
appears, will finish the installation process. If you want to stop installing the software, 
click the "Cancel" button.  

We recommend you leave all options to their default setting, especially if you are unsure 
of what option to select or what the actual implications are if the option was to be 
changed. 

The drivers required to operate your USB interface are installed as part of the main 
installation process. From time to time updated drivers may be released by LogTag 
Recorders. If you are operating on Windows XP or Windows Vista these drivers will be 
available through the Microsoft Windows ® Update feature, as an optional hardware 
update. 
 

Upgrading from earlier 
versions 
If you are installing a newer version of LogTag Analyzer on a computer, which already has 
an earlier version installed, the old installation will be replaced by the newer version. 

Any previously installed unsigned USB drivers will not be replaced automatically. To 
replace the USB drivers you will need to go to Windows Update and select the FTDI - USB 
Interface update from the "Other hardware" section. 

Please refer to your Operating System manual or help on how to access this feature.  

 

You can also update your driver from the Control Panel device manager. Please see 
Resolving USB Driver Problems (on page 151) later in this document. 









 

124 LogTag Analyzer User Guide (2.0)  
 

 
 

Window Menu 
The "Window" menu contains commands that relate to the management of each Window 
open within the LogTag Analyzer software that displays the contents of a LogTag file.  

 

The following table outlines the commands and the explanation of each command that 
may appear in the "Window" menu when using the LogTag Analyzer software: 

Command Explanation 

New Window Opens a new window that contains a copy of the information of 
the currently selected window. This command is useful when 
you need to closely inspect and analyze different sections of the 
same data set. 

Close Closes the currently selected window within the LogTag 
Analyzer software. 

Close All Closes all the windows within the LogTag Analyzer software. 

Cascade Arrange all the windows within the LogTag Analyzer software in 
an overlapping style. 

Title Horizontally Arrange all the windows within the LogTag Analyzer software as 
horizontal non-overlapping tiles. 

Title Vertically Arrange all the windows within the LogTag Analyzer software as 
vertical non-overlapping tiles. 

Arrange Icons Arrange all the minimized windows within the LogTag Analyzer 
software at the bottom of the main window. 
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1, 2, 3, etc The tick mark beside these entries indicates the window that is 
currently selected. If you want to change the currently selected 
window to one of the windows listed, just click/select the 
appropriate entry on this list. 

 
 

Help Menu 
The "Help" menu contains commands that relate to providing you with help and 
assistance with using the LogTag Analyzer software.  

 

The following table outlines the commands and the explanation of each command that 
may appear in the "Help" menu when using the LogTag Analyzer software: 

Command Explanation 

Help Topics ( ) Opens a window that contains the online help. 

User Guide ( ) Opens the online user guide for viewing. Requires Adobe 
Acrobat and/or Adobe Acrobat Reader software, version 4 
or later, to be installed on the computer. 

LogTag Home Page... ( ) This will open your default Internet browser software and 
display the LogTag Recorders Internet site, 
www.logtagrecorders.com. This command requires that 
your computer be currently connected to the Internet to 
successfully display the LogTag Recorders Internet site. 

Request help (see "Getting more 

help" on page 141)... ( ) 

This will gather non personal information from your 
system to include in the e-mail to be sent to software 
support at LogTag Recorders, so that the support team 
will be informed of the relevant information about your 
system in order to provide you with quality and useful 
assistance. This command is explained in further detail in 
the chapter "Getting more help (on page 141)". 
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Check Internet for update (see 
"Getting updated software" on 
page 138)... 

This is a simple way of checking to see if there is a newer 
version of this software available for download. This 
command is explained in further detail in the chapter 
"Getting updated software (on page 138)". 

About LogTag Analyzer (see 
"Finding your software version" 

on page 140)... ( ) 

Display the version information about the LogTag 
Analyzer software that you are using. 

 
 

Toolbar commands 
Each picture on the toolbar represents a unique command. 

 

The pictures that are included on the toolbar represent the following commands: 

 This will bring up the LogTag Wizard, which will take you through the steps to retrieve 
readings from connected LogTag(s) and prepare them for their next use.  

 This will display the file open window to allow you to locate and open LogTag files that 
contain previously retrieved LogTag readings. 

 Save a copy of the LogTag data to a file on your disk drive. 

 Opens the window that will allow you to print a copy of the LogTag data to a printer. 

 Displays file properties about the currently selected open file. 

 Displays information about any digital signatures included in the currently selected 
open file, which is also allows where new digital signatures can be added to the file 
and where you can print a copy of the digital signatures. 

 Creates a new blank e-mail for sending a copy of the currently selected open file as an 
attachment to a recipient of your choice.  

 Manually Uploads the currently active file to an FTP site or e-mails the file to a 
pre-determined recipient list. This button image changes depending on the selected 
automation settings, please see Automatic e-mailing and uploading to FTP sites on 
page 93. 

 Places a copy of the currently displayed information to the Windows clipboard so that 
you can paste it into another Windows software package. 
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 Zooms out one level of the actively displayed chart. If you are displaying a chart and 
this function is not available, then all data that is available to be displayed is currently 
been displayed and therefore there is no more additional information that can be 
displayed by zooming out. 

 This zooms the chart to show information between the oldest reading recorded and 
the first inspection mark that exists amongst the data. If this function is not available 
then there is no inspection marks in the data currently been displayed. The next two 
commands will not be available until this command is activated. 

 This zooms the chart to show the group of data that was recorded between the 
previous inspection mark and the first inspection mark currently been displayed. This 
function is disabled when either the oldest reading is already been displayed or the 
chart has not been zoomed into showing groups of readings between inspection 
marks.  

 This zooms the chart to show the group of data that was recorded between the next 
inspection mark and the last inspection mark currently been displayed. This function is 
disabled when either the newest reading is already been displayed or the chart has not 
been zoomed into showing groups of readings between inspection marks.  

 Switches into Multi Chart mode, which displays all currently open charts together in 
one window. If additional LogTag(s) are downloaded or more files opened, their data 
will be added to the Multi Chart window. 

 Switches into Multi Chart mode, with the average tabs active, or if already in 
multichart, activates or disables the average tabs. It is recommended to deactivate 
this feature when processing large data sets, as Minimum, Maximum and Average 
Charts (see "Special Chart Tabs" on page 68) can require considerable memory and 
processor resources when activated. 

 Switches into Single Chart mode. Each chart that is currently open will be displayed in 
its own window. 

 This will open a window allowing you to customize the software. This command is 
further explained in the chapter "Customizing the software (on page 86)". 

 This will log a user on to the software if no user is currently logged on or log off the 
currently logged on user. This command will only be available if the software is 
connected to the LogTag User Server software. 

 This will allow you to show the help topic on any particular command or topic that you 
subsequently select. 

 
 

Print preview toolbar 
The print preview feature, available through the File menu (on page 119), of the software 
will display copy of the data as it would be included on a print out. When the software is 
displaying a file in print preview mode, an additional toolbar will appear, similar to the 
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following picture. 

 

Command Explanation 

Print (see "Printing the 
results" on page 76)... 

This will open a window allowing you to print a copy of the 
LogTag file to an output device, which will typically be a 
printer. This command is further explained in the section 
"Printing the results (on page 76)". 

Next Page This will display the next page included in the print out. This 
button will be disabled if there are no more pages available to 
be displayed. 

Prev Page This will display the previous page included in the print out. 
This button will be disabled if there are no previous pages 
available to be displayed. 

One Page Selecting this button will change the display so that only one 
page is displayed at a time. Once this button is selected it will 
change to "Two Page". 

Two Page Selecting this button will change the display so that two 
consecutive pages are displayed side by side at the same time. 
This button will be disabled if there is only one page in the 
print out, like a chart. Once this button is selected it will 
change to "One Page".  

Zoom In This will zoom in the display of the print out making it appear 
larger on the screen. It will not effect what information is 
included in the print out. 

Zoom Out This will zoom out the display of the print out making it appear 
smaller on the screen. It will not effect what information is 
included in the print out. 

Close This will close the print preview mode of display and revert the 
display of the data back to normal mode, which will allow 
users to switch between chart display and data listing display, 
for example. 
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Standard Window commands 
In the top right corner of each window, one or all of the buttons in the following image 
will be displayed and will (from left to right) minimize the window, maximize the window 
or close the window. 

 

The following picture illustrates an example of the menu that will appear if a user selects 
the icon in the top left corner of the LogTag Analyzer software, usually by clicking the left 
mouse button on it, or by clicking the right mouse button on the title bar (see "Menus and 
Toolbars" on page 117). The commands illustrated in the following picture allow you to 
change the location and/or size of the window containing the LogTag Analyzer software. 
Users can also move the window containing the LogTag Analyzer software by "dragging" 
the title bar, which is typically performed by pressing and holding the left mouse button 
down over the title bar of the software and moving the mouse to the new location for the 
window. 
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The following picture illustrates an example of the menu that will appear if a user selects 
the icon in the top left corner of a data file window, usually by clicking the left mouse 
button on it, or by clicking the right mouse button on the title bar (see "Menus and 
Toolbars" on page 117) of the data window. These menu commands will only effect the 
window containing the data retrieved from a LogTag rather than the Window that 
contains the entire LogTag Analyzer software. 
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When using and deploying software in a network environment, network administrators 
often require additional technical information about the software so they can integrate 
support for it correctly and seamlessly. This chapter briefly covers some points of interest 
for computer network administrators. 

In This Chapter 

Distributing software to workstations ....................... 132 
Simple Distribution of FTP/SMTP settings ................. 133 
Restricting what users can do ................................. 134 
How users log on ................................................... 135 
How users change their password ........................... 136 
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Distributing software to 
workstations 
When using the software on many computers within a computer network, it is not always 
efficient to visit and install the software and subsequent updates manually on each 
computer workstation. The installation of the software does support zero administration 
installation, whereby the installation package can be located on a central point, usually a 
server, and have it install on each relevant workstation, without requiring user 
intervention. 

To distribute the software without user intervention is a two step process. 

1 Create an installation script file that will provide the answers and actions to be 
performed on each step of the installation process. To create an installation script, use 
the following command line syntax, including the quotes as used: 

\\myserver\my_apps_path\setup.exe /a /r /f1"\\myserver\my_apps_path\setup.iss" 

2 Ensure that whenever a user installs the software the installation script is used. To 
install the software using an installation script previously created use the following 
command line: 

\\myserver\my_apps_path\setup.exe /a /s /f1"\\myserver\my_apps_path\setup.iss" 

Where,  

a "\\myserver\my_apps_path\" represents the network path to the folder containing the 
installation of the LogTag Analyzer software.  

b "setup.exe" is the installation software.  

As many different installation scripts as are suitable for your situation may be defined and 
used. 

LogTag Analyzer software is released on the LogTag Recorders Internet site using a 
standard filename syntax, which is  
[software_name][major_version][minor_version]r[release_version].exe. For example, if 
the file name of the installation package was "logtag_analyzer10r24.exe" the name of the 
software would be "LogTag Analyzer" version 1.0 Release 24.  

The installation of the LogTag Analyzer software involves copying a number of files to the 
destination folder, which can be chosen during the installation process, a file is installed in 
the Windows System folder and some plug and play drivers to support the USB Interface 
Cradle. Therefore, when deploying the software onto Windows NT® based operating 
systems, like Windows NT®, Windows 2000® and Windows XP®, the user installing the 
software will require local administrator privileges for the software to install correctly. It is 
possible, to elevate a users permissions on a Windows NT® based server network for the 
sole purpose of being able to install the software successfully through the use of a Group 
Policy Object.  
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When installing the software on to a Windows NT® operating system, the plug and play 
drivers for the USB Interface Cradle will not be installed as Windows NT® does not support 
USB devices. 
 

Simple Distribution of 
FTP/SMTP settings 
Some users may experience difficulties entering the correct parameters for automated 
FTP uploads and automatic SMTP mailer settings, in some instances a Network 
Administrator may even wish to prevent the changing of these settings by standard users. 

For those situations Network Administrators can create a file containing FTP upload and 
SMTP mailer settings for individual users, which will be imported automatically into 
LogTag Analyzer on start-up and replace the settings already present in the Options for 
Automation. 

Creating such settings files requires a tool called LogTag Settings Editor, which is available 
through your distributor. There are two different versions of this tool, one for the 
Standard LogTag Analyzer version, one for the Unicode LogTag Analyzer version. Files 
created for the Standard version will not work for the Unicode version and vice versa. 

Starting the LogTag Settings Editor displays a simple interface offering the same controls 
as they are present in the Option - Automation window for the FTP upload and SMTP 
mailer settings, with additional controls to save and load settings files. 

Network Administrators are expected to be familiar with the parameters required for these 
settings, for a description of each entry see Automatic Uploading to FTP sites and 
automatic e-mailing on page 93. 
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At any stage the settings entered can be saved into a file, and previously created files can 
be loaded again and changed or saved with a different file name. 

The file name for this file can be selected freely by the Network Administrator. To make 
use of the automated transfer settings, however, the file must be named 
"UploadSettings.dat". On start-up LogTag Analyzer will look for this file in the same 
directory as the "UserProfile.dat" file (which holds the settings for an individual installation 
of LogTag Analyzer). You can find this file in C:\Users\#USER#\AppData\Roaming\LogTag 
for Windows™ Vista or C:\Documents and Settings\#USER#\Application Data\LogTag for 
earlier Windows™ versions. 

Note: The name of the file that will automatically be imported into the Unicode version is 
"UploadSettingsU.dat". The slightly different file name will prevent Standard character set 
software to import Unicode settings and vice versa, which would result in neither 
password nor user logon to be imported correctly. 

If the file is found, the settings will be imported into the Options - Automation entries and 
also saved in the "UserProfile.dat" file. Upon successful transfer the "UploadSettings.dat" 
file will be renamed to UploadSettings_imported.dat and no longer be read during any 
subsequent start-up of LogTag Analyzer. All fields including the empty ones will be 
transferred, not only the filled fields.  

Unless editing the Automation options is specifically prohibited through LogTag User 
Server, users can still change FTP upload and SMTP mailer settings even after transfer 
from the "UploadSettings.dat". Should it be necessary to transfer the settings again, or 
transfer new settings, the existing file can be renamed to "UploadSettings.dat", or a new 
"UploadSettings.dat" file can be copied into the folder. The transfer process will then be 
executed once more when LogTag Analyzer next starts. 

Note: LogTag Analyzer will import the "UploadSettings.dat" file if located in the correct 
directory, even if LogTag User Server has specifically prohibited editing the Automation 
Options. In this case, if an incorrect setting is imported, the only way to remove this 
setting is by importing a different "UploadSettings.dat" file with different parameters, or 
to change the user's permission settings to include the ability to edit the Automation 
settings in the Options. 

Note: When you wish to distribute the settings to computers using the Windows 2000 OS, 
the LogTag Settings Editor must be used in a Windows 2000 environment to create the 
"UploadSettings.dat" file. If a file is imported into Windows 2000 not created in this OS, 
the user name and password for FTP and SMTP Authentication are not uploaded due to 
the missing support for the encryption method employed in later versions of Windows. 
 

Restricting what users can do 
In a multiple user environment, it is not always desirable to allow every user to perform 
any and all tasks with the software. For example, to ensure all documents printed from 
the software use the same date/time display format, it may be desirable to not allow 



 

 Chapter 8    Working with Networks 135 
 
 

users to customize the software to change how the software displays dates and times. To 
provide administrators of systems with a central point of control, LogTag Recorders has 
developed a software package called "LogTag User Server", which when used in 
conjunction with this software, it will provide an administrator with the ability to choose 
whether or not to restrict what users can and cannot do with this software. 

To find out more about LogTag User Server, please contact your network administrator 
and/or your LogTag reseller. 
 

How users log on 
When the software has been customized (see "Customizing the software" on page 86) to 
be connected to the LogTag User Server (see "User Server" on page 114) software, all 
users are required to successfully logon to the software before being permitted to use any 
of the features and functionality of the software. For a user to successfully logon to the 
software, the user must enter their username, which the administrator would have 
assigned, and their password. Username's are typically not case sensitive, however 
passwords are. That is, entering the Username "Bob Smith" is the same as entering "BOB 
SMITH" and "bob smith". However, entering a password of "bob" rather than "Bob", for 
example, is considered to be different. 

 

Every logon attempt, whether successful or not, may be recorded automatically in the 
audit logs by the administrator. As a security measure, the network administrator may 
configure the LogTag User Server (see "User Server" on page 114) software so that a 
user account becomes locked and therefore temporarily inaccessible if a certain number 
of consecutive failed logon attempts are made to the user account. Please contact your 
network administrator if you have problems with the logging on the software. 
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How users change their 
password 
When the software has been customized (see "Customizing the software" on page 86) to 
be connected to the LogTag User Server (see "User Server" on page 114) software, the 
network administrator may require and/or permit users to change the password used to 
logon to the software. Users are only permitted to change the password for the user 
account that is currently logged on, which is typically their own, and as a security 
precaution, users will always need to supply their current logon password before being 
permitted to change it.  

The network administrator may enforce certain rules pertaining to what is a valid 
password. For example, they may require a minimum number of characters (digits, letters 
or symbols) and/or a minimum number of digits to be included in the password. Please 
contact your network administrator if you have problems with the logging on the 
software. 

 

Passwords should be chosen such that they would be difficult for some one else to guess. 
If another person was able to guess the password they would be able to logon and 
impersonate the user. Therefore, following are a few points to remember when changing 
a password: 

1 Do not use something that is personal to the user. Birth dates, license plate numbers, 
names of family members, types of vehicles owned, favorite foods and address of 
residence are all examples of passwords that should NOT be used. 

2 Do not write it down. 

3 Change the password on a regular basis. 

If a user's password is forgotten, the network administrator will be able to change it. 
However, network administrators will not be able to see and therefore inform users what 
their current password is. 
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Getting updated software 
There are two ways to see if a newer version of the LogTag Analyzer software is available 
and download a copy if a newer version exists. 

1 Within the "Help" menu item in the software is a command called "Check Internet for 
update..." 

 
2 Visit the LogTag Recorders Internet Site, www.logtagrecorders.com, and follow the 

relevant instructions to obtain a copy of the software. 

The first option will download from the LogTag Recorders Internet site the relevant 
information about the latest version of the software available and compare this 
information with the software that has already been installed. The software will then let 
you know whether or not a newer version of the software is available. During this entire 
process no information about you or your system is transmitted out from the LogTag 
Analyzer software and therefore you can rest assured that your privacy is maintained. 
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While the software is retrieving the information from the Internet about the latest 
available version, the software will display its progress in a window similar to the following 
picture. 

 

If a newer version of LogTag Analyzer is available a "Download" button will appear. 
Clicking "Download" will begin the download process, in which you select the location for 
the installation file. After the installation file has been downloaded you will need to close 
LogTag Analyzer and then start (open) the downloaded file to begin the installation. 

Installing a newer version of the LogTag Analyzer software will update all the relevant 
program files. It will not affect any of your LogTag data files or your custom settings of 
the software. Software updates usually include feature enhancements and/or resolve 
problems discovered with the software subsequent to its release. We recommend you use 
the latest version of the LogTag Analyzer software available. 

LogTag Analyzer can automatically check if a newer software version is available. The 
interval between automatic checks for an update can be specified through the Updates 
(see "Software Updates" on page 115) section from within the Options (see "Customizing 
the software" on page 86) Window. 
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Finding your software version 
Within the "Help (see "Help Menu" on page 125)" menu, is the "About LogTag Analyzer..." 
command, which will display a Window similar to the following picture. 

 

Within this window, amongst other information, the full version number of the software 
being used is displayed. This information is useful, for example, to determine if the same 
software version is installed on multiple computers and/or if the user guide being 
referenced refers to the version of software being used.  

For example, if the window shows the software to be "LogTag Analyzer 2.0" and the 
version of this guide is 2.0, then the contents of this user guide refer to the version of 
software being used. If however, this window shows the software to be "LogTag Analyzer 
1.0" and the version of this guide is 2.0, then this version of the user guide does not refer 
to the version of the software being used. The version of this guide is 2.0, which is also 
shown on the cover page of the guide.  

Each time the software is updated one part of the version number of the software is 
always increased. The "Build" number portion is increased for a given version of the 
LogTag Analyzer software when the change included in the software will not affect the 
matching version of the user guide. For example, version 2.0 of the guide refers to both 
the "LogTag Analyzer, Version 2.0 Build 2" and the "LogTag Analyzer, Version 2.0 Build 5" 
of the software.  
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Getting more help 
The time may arise when this guide is unable to provide you with the assistance you 
require. The LogTag Analyzer software includes a way to make the process of getting 
further assistance from LogTag Recorders as simple as possible, while providing the 
support team at LogTag Recorders with enough information about your system to be able 
to provide you with useful assistance. Within the "Help" menu of the software is a 
"Request help..." command.  

 

This command will gather non personal information from your system to include in the 
e-mail, which you can review if you want to, so that LogTag Recorders will be informed of 
the relevant information about your system in order to provide you with quality and useful 
assistance. Please include in the e-mail as much information and detail about the problem 
that you are experiencing with the LogTag Analyzer software as possible, even if you may 
think it to be irrelevant, as the more information that is available the more likely LogTag 
Recorders will be able to provide you with an appropriate solution quickly. 

If you have suggestions for software improvements, you may also use this method to 
send your ideas through as LogTag Recorders is always in the process of improving the 
software and adding additional features to it, so that the software becomes increasingly 
more efficient, effective and useful for users. 
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Troubleshooting 

Problem Solution 

My LogTag appears to be “dead”. No 
lights are flashing. 

This could represent either of two conditions: 

1 The LogTag is ready to start, but has not 
been started yet. 

2 The LogTag is simply in a state where the 
configuration has the LED flashing turned 
off. This is an option that may be selected 
when a LogTag has been shipped to the 
user for the first time (to preserve battery 
life) or it may be that the last configuration 
setting selected no LED display. 

3 The LogTag is in "Hibernation" mode. Refer 
to "Prolonging battery life (on page 45)" for 
further information. 

4 The battery is dead and the LogTag is 
expired. 

How to test:  

1 Try pressing the START MARK button on the 
LogTag. 

2 Start the LogTag Analyzer software and 
place the LogTag into the Interface Cradle. 
Download the LogTag. If the LogTag can be 
identified by the software, then the battery 
is good, and the LogTag is OK. 

I am unable to get a serial port “free”. 
Every time I run the software, every 
port shows that is already in use 

On rare occasions it may be difficult to configure 
some computers for releasing the assignment of a 
serial port from one application to another. Often, 
this will require the services of a computer technician 
or expert. One simple solution is to purchase a USB 
Interface Cradle. USB connections do not have a 
“free port” limitation. 

What happens if there is an electrical 
current between the contacts…will 
that damage the LogTag? 

The contacts are isolated from the critical internal 
component such that incidental static discharge will 
not harm the LogTag. Deliberate application of a full 
outlet voltage (100 – 240 volts AC or 12-24 volts DC) 
to the LogTag may cause permanent damage. 
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I cannot view the user guide that 
came with the software. 

The User Guide is in a 'PDF' file format and as such a 
special software package called "Acrobat Reader" is 
required to view it. Acrobat Reader is available for 
free download from the Adobe web site and can 
typically be downloaded from 
http://get.adobe.com/reader/ 
(http://get.adobe.com/reader/)  

I cannot see all the readings in the 
"data" screen, some appear to be 
missing. 

The range of readings shown in the data screen 
represent the range of readings shown on the Chart 
screen. Whenever the Chart is zoomed in to show 
more detail the range of readings shown in the data 
screen is updated as well. If the chart is zoomed out 

( ) to show all readings that were recorded, then 
the data screen will also show all the readings that 
were recorded. 

Why are some of the readings shown 
"non validated". 

The LogTag automatically inserts error detection 
codes every 127 recordings which checks for the 
detection of corrupted or manipulated data. If the 
LogTag has been configured to do continuous 
recording (see "Continuous operation" on page 43) 
then as each block of 127 logs is started to be 
replaced with the latest readings the data integrity 
error check for the "oldest" block will fail, which will 
therefore technically putting the block of data into 
doubt. This is not a problem rather that the 
particular block of data now has the lost a degree of 
data integrity protection and hence is labelled 
'non-validated'. 

Non-validated readings can also occur if there has 
been communications issues during data transfer 
from the LogTag or if the memory does actually have 
a fault, however these causes are very rare. 

  

If above suggestions are insufficient, please check the website at www.logtagrecorders.com for 
more information, specifically the FAQ section. 
 

Finding your computer 
specifications 
If you are unsure of your computer specifications you can find the relevant information by 
following these steps: 

1 To determine your computer CPU, RAM and version of Windows Operating system: 
 

a) Open the "Control Panel". This can be done by using the mouse to click on the 
Windows "Start" button, typically located in the bottom left of the screen, to open 
the Start menu. 
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b) Once the "Start" button has been clicked, you will see a menu appear.  

c) If your menu looks similar to the following picture, click on the visible "Control 
Panel" item. 

  



 

146 LogTag Analyzer User Guide (2.0)  
 

d) If your menu looks similar to the following picture, the "Control Panel" item is 
located within the "Settings" menu item. 

 
e) Within the "Control Panel" window there is a "System" icon. For Windows XP users, 

you may need to "Switch to Classic View" to locate the "System" icon quickly. Start 
(open) the "System" icon once you have located it. 
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f) Clicking on the "General" tab at the top of the "System Properties" window, which 
is usually the default, will display the relevant information for you about your 
system. 

 
2 To determine your screen resolution and colors: 

a) Open the "Control Panel" as explained in step 1. 

b) Open the "Display" item. 

c) Click on the "Settings" tab at the top of the "Display Properties" window will 
display the relevant information for you about your display. 
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d) From the "Settings" portion of the "Display Properties" window you will see your 
current screen settings and you may also be able to change some of your display 
settings if you want.  

 
3 To determine your spare hard disk drive space: 

a)  Open "My Computer" which is typically located on your desktop and/or within the 
Windows "Start" menu. 
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b) Using your mouse, click the button on the right over the drive that includes "(C:)" 
in its description. 

 
c) Select "Properties" (left mouse click) from the popup menu that will appear. 
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d) Clicking on the "General" tab at the top of the drive properties window will display 
the relevant information for you about your hard drive. 

 
e) If you have multiple (hard disk) drives installed on your computer you can repeat 

steps (b) through to (d) for each drive to get the same type of information. 
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Resolving USB Driver 
Problems 
Every USB device requires the appropriate driver files to be installed prior to them being 
successfully used on a computer. The installation process of the LogTag Analyzer software 
will attempt to ensure the appropriate driver files are installed on the computer. 

The USB drivers included in the LogTag Analyzer installation program are Microsoft WHQL 
certified. They can also be downloaded through the Windows Update service. If USB 
Interface Cradles are connected prior to running the LogTag Analyzer installation 
program, Windows will attempt to install the drivers through Windows Update. If your 
computer is not connected to the internet, or you choose not to let Windows search for 
the driver online, you will need to manually update the drivers on your system. 

It is strongly recommended that the software is installed prior to any USB Interface 
Cradles being connected to the computer. 

The following sections will guide you through the steps necessary to determine whether 
or not a problem exists with the installation of the USB drivers for the USB Interface 
Cradle are installed correctly on the computer and, if necessary, how you can resolve a 
problem with the installation of the USB drivers. 

In This Section 

Checking the installation of the USB driver ............... 151 
USB driver installation through software installation . 157 
Manual USB driver installation on Windows XP ......... 159 
Manual USB driver installation on Windows 2000...... 163 
 
 

Checking the installation of the USB driver 
The following will guide you through the steps necessary to determine whether or not the 
drivers for the USB Interface Cradle are installed correctly on the computer. 
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1 Providing the LogTag Analyzer software has been already installed, connect the USB 
Interface Cradle to the computer by plugging the Interface into an available USB 
socket. USB sockets are typically located at the rear of the computer. 

 
2 Open the "Control Panel". This can be done by using the mouse to click on the 

Windows "Start" button, typically located in the bottom left of the screen, to open the 
Start menu. Once the "Start" button has been clicked, you will see a menu appear.  

3 If your menu looks similar to the following picture, click on the visible "Control Panel" 
item. 
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4 If your menu looks similar to the following picture, the "Control Panel" item is located 
within the "Settings" menu item. 

 
5 Within the "Control Panel" window there is a "System" icon. For Windows XP users, 

you may need to "Switch to Classic View" to locate the "System" icon quickly. Start 
(open) the "System" icon once you have located it. 
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6 If your system properties looks similar to the following picture, click the "Hardware" 
tab followed by the "Device Manager" button to open a view of the devices that have 
and have not been successfully installed on the computer. 
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7 If you system properties looks similar to the following picture, click the "Device 
Manager" tab to view the devices that have and have not been successfully installed 
on the computer. 
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8 Once the device manager is open you should see one of the three following images in 
the list, as indicated in the following picture. You may need to click on the "+" beside 
the "Universal Serial Bus controllers" entry to view all the USB devices that have been 
installed on the computer. 

 

If the USB device driver installed successfully but has not yet started, the following will 
guide you through steps necessary to start the USB drivers so that you can start using the 
USB Interface Cradle(s).  

If the computer is using Windows XP or Windows 2000: 

1 Open the "Device Manager" as described previously. 
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2 For each "USB Interface" entry displayed, using the mouse (pointing device), click the 
right button on the text of the "USB Interface" entry to display the popup context 
menu, which will be similar to the following picture. Once this pop context menu is 
visible, select the "Uninstall" option, using the left button on the mouse. 

 
3 Unplug all USB Interface Cradles that are plugged into the computer and/or are 

plugged into any USB hub that may be connected to the computer. 

4 Wait for at least 5 seconds. 

5 Plug the USB Interface Cradle(s) into the appropriate USB socket on the computer 
and/or USB hub that is connected to the computer. This should install and start the 
USB driver for the USB Interface Cradle(s). If the drivers do not successfully start, 
indicated by the "USB Interface" entry appearing in the device manager with either 
the  or the  picture, you may need to reinstall the USB driver files, which is 
described subsequently. 

If the USB device driver files did not install correctly, you may either reinstall the software 
or manually install the USB driver files. This set of USB drivers was first released with the 
LogTag Analyzer software version 1.7. If you have a version of the software prior to this, 
get a copy of the latest version of the LogTag Analyzer software and install the latest 
version of the software ensuring the all USB Interface Cradles are not connected to the 
computer during the installation process. 
 

USB driver installation through software 
installation 
You can install the USB drivers by re-installing the LogTag Analyzer software : 

1 Unplug all USB Interface Cradle(s) connected to the computer and/or connected to a 
USB hub connected to the computer. 

2 Start the Windows "Control Panel" 
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3 Within the "Control Panel" window there is an icon which allows you to un-install or 
change already installed programs: 
- In Windows 2000 this is called  "Add/Remove Programs" and looks like this: 

 
 
- In Windows XP it is called "Add or Remove Programs" and looks like this: 

    
 
- In Windows VISTA it is called "Programs and Features"  and looks like this: 

  
 
Windows XP and Windows Vista users may need to "Switch to Classic View" to locate 
this icon quickly. 

Start (open) the "Add or Remove Programs" icon once you have located it. 

4 Locate the "LogTag Analyzer" entry and click the "Change" button. 

5 Once the "LogTag Analyzer Setup Maintenance" window is open, select the "Repair" 
option and then click the "Next >" button. 

6 Click the "Finish" button when it is displayed to complete the reinstallation of the 
software and USB driver files. 

 
 



 

 Chapter 10    Appendix 159 
 
 

Manual USB driver installation on Windows XP 
To manually update the USB driver files, for Windows XP computers, open the "Device 
Manager". The "Device Manager" can be started by opening the "System" icon, located in 
the Windows "Control Panel", selecting the "Hardware" tab in the "System Properties" 
window and then click the "Device Manager" button. 
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1 Using the mouse (pointing device), click the right button to display the popup context 
menu, which will be similar to the following picture. 

 
2 Select the "Update Driver..." option, using the left button on the mouse, which will 

cause the device driver wizard to start, similar to the following picture. 

You can either let Windows search and download the USB driver online from Windows 
Update, or select the "Install from a list or specific location (Advanced)". Click the 
"Next >" button to continue. 

 
3 When prompted for the location of the driver files, enter the location of the installation 

of the software followed by the path to the USB driver files. The default location for 
these driver files is "C:\Program Files\LogTag Recorders\LogTag 
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Analyzer\Drivers\i386" ("C:\Program Files\LogTag Recorders\LogTag 
Analyzer\Drivers\amd64" for 64-bit Windows systems). You may use the "Browse..." 
button in the window that appears, similar to the following picture to help you locate 
the appropriate folder. 
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4 Once the driver files have been installed successfully you will see a window similar to 
the following picture. You may now connect and start using your USB Interface 
Cradle(s). 
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Manual USB driver installation on Windows 2000 
To manually reinstall the USB driver files, for Windows 2000 computers, open the "Device 
Manager". The "Device Manager" can be started by opening the "System" icon, located in 
the Windows "Control Panel", selecting the "Hardware" tab in the "System Properties" 
window and then click the "Device Manager" button. 
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1 Using the mouse (pointing device), click the right button to display the popup context 
menu, which will be similar to the following picture. 

 
2 Select the "Properties..." option, using the left button on the mouse. 

3 From the "USB Interface Properties" window that will appear, similar to the following 
picture, click the "Reinstall Driver..." button. 

 




